
 

 

 
 

Release Notes srn027 
PSoC Designer Version 4.4 

Release Date: March 21, 2007 
 
Thank you for your interest in PSoC Designer™ version 4.4. This document lists installation 
requirements and describes software updates and changes. 
 
System Requirements and Recommendations  
 
System Requirements Minimum Recommended

 Processor Speed 500 MHz 1 GHz 
 MB of RAM 256 MB 512 MB 
 MB of Free Hard Drive Space 250 MB 300 MB 
 Screen Resolution 1024x768 1280x1024 
 CD-ROM Drive   
 USB Port, preferably Open Host Controller or Universal   
 Windows® 2000, XP (SP 1 or 2), or Vista 32 bit   
 Microsoft Internet Explorer 6.0 (SP1)   
 Adobe Reader (For Viewing of .PDF Documentation)   
 PSoC Programmer (2.30)   

 
Installation Issues 
 
Installation issues on all Microsoft Windows operating systems: 

1. The following error message will occur 4 times during USB driver installation: “Driver has 
not passed Windows Logo Testing.” When you proceed with installation, the drivers will 
successfully install. 

2. The uninstall feature will only remove files that were installed by the installer.  

3. The PSoC Designer 4.4 installer writes over your current version, and no longer asks if 
you want to remove the previous version. If you remove PSoC Designer 4.4, there will be 
some files from PSoC Designer 4.3 that will remain in the installed folder. 

4. There may be a choice of two drivers for the MiniProg and ICE-Cube, if you previously 
had PSoC Designer installed on your computer. 

"USB Mini Programmer" 

"USB Mini Programmer (Mar19,2007)"  

Choose the Mar19,2007 driver, which is the most recent driver.  

Downloads 
 

Future service and extension packs will be available for download at www.cypress.com/pd44sp. 

Check http://www.cypress.com/psocdesigner, and http://www.cypress.com/psocexpress  for the 
latest downloads of software and documentation. 
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Archived Release Notes 
 

Previous versions of release notes are provided as a convenient reference at 
www.cypress.com/releasenotes. 

New for 4.4 
 

This version primarily makes changes to PSoC Designer to enable it to execute under Microsoft 
Windows Vista 32 bit. Other new features include: 

1. All PSoC Designer 4.3 service and extension packs have been rolled up into PSoC 
Designer 4.4. The service packs and extension packs include: 

a. Service Packs 1 and 2 

b. EP_NewUM Extension Pack Versions 1, 2, and 3 

c. EP_CY8C20x34 Extension Pack Versions 1 and 2 

d. EP_CY8C24x94 Extension Pack Version 1 

e. EP_CYRF69xx3 Extension Pack Version 1 

f. EP_LED Extension Pack Version 1 

2. CSD, CSR, and CSA User Modules are now compatible with multiple configurations. 

3. A low power comparator (CMPLP) user module was added. 

4. The CSA ScanSensors API function no longer carries the RAM/ROM overhead of the 
high level API when used in a project. 

5. The ADC10 User Module data sheet includes more detailed explanation on calibration 
and parameter settings. 

6. A new spreadsheet called SSlopeCalc.xls has been added to help you set parameters for 
the ADC8, ADC10, and DualADC. You can find the new spreadsheet by selecting Help > 
Documentation and then opening the ADC_SingleSlope folder. This spreadsheet may 
be used for the ADC8. However, the ADC8 does not have a parameter to set the current 
from high to low. The current can be set high to low by directly changing the register 
ADCx_CR.  

Integrated from PSoC Designer 4.3 Service Pack 1: 
 

1. User Module data sheets now include links to example projects on the Cypress website. 
Currently, Cypress is developing and testing over 80 PSoC Designer User Module 
example projects and PSoC Express driver-based example projects.   
http://www.cypress.com/psocexampleprojects will be updated incrementally throughout 
2007 with these new example projects. 

If you do not see the example project you are looking for today, feel free to contact our 
Applications Support phone number listed below, or create a customer support web case. 
The Applications group may be able to provide an early BETA version or prioritize the 
completion of your requested design example. 1.800.669.0557 ext. 4814 (US, Canada), 
+1.425.787.4814 (International). 
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2. The file flashblock.asm was updated to provide support for the CY8C20x34, CY8C21x34 

and CY8C21x23 devices at VDD below 3V. 

3. The CapSense wizard was updated to correctly generate firmware when 10 or more 
buttons are selected. 

4. The CSR User Module bUpdateBaseline function was updated to correctly generate 
baselines for multiple sensor groups. 

5. The CSR User Module was updated to support maximum sensors (28 on CY8C21x34 
and 48 on CY8C24x94). 

6. The extended temperature devices CY8C24x23-12PVXE were updated to be set at boot 
time to run at a max frequency of 12MHz. 

7. A possible condition that put PSoC Designer into an infinite loop when updating a design 
using the CSR wizard was corrected. 

8. The LED User Module was updated use shadow registers that support a large memory 
model (LMM). 

9. The CSR User Module function GetCentroid was updated to return a zero if there are no 
active sensors and the slider is not diplexed. 

Integrated from PSoC Designer 4.3 Service Pack 2: 
 

1. Fixed ICE connection failure on some dual core processors by supplying new 
iceconnection.dll file.  

See I2C Bootloader Notes on page 8 for additional updates in Service Pack 2. 

Integrated from PSoC Designer 4.3 EP_NewUM Extension Pack Version 1: 
 

1. New Digital Communication User Module added: SDCard. 

This SDCard (Secure Digital Card) User Module is only supported on the part family 
CY8C29xxx. Supports file systems FAT16 and above. Example projects are located in  

<install path>\CypressMicroSystems\PSoCDesigner\Examples\SDCard 

2. Protocol User Modules: USBUART. 

This USBUART User Module is only supported on the part family CY8C24x94.  

  

Integrated from PSoC Designer 4.3 EP_NewUM Extension Pack Version 2 and 3: 
 

1. New CapSense User Module added: CSD. 

CSD User Module support added for the CY8C21x34 part family in Service Pack 1. 

CSD User Module support added for the CY8C24x94 part family in Service Pack 2.  
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Integrated from PSoC Designer 4.3 EP_CY8C20x34 Extension Pack Version 1: 
 

1. Device support for CY8C20234, CY8C20334, and CY8C20434. 

2. CapSense User Module: CSA. 

3. Digital Comm. User Modules: I2CHW (slave only), I2Cm (software master only), SPIM, 
SPIS. 

4. Misc. Digital User Modules: LCD. 

5. Timer User Modules: TIMER13. 

6. EEPROM User Module: E2PROM. 

• Flash Library is updated for CY8C20x34. 

Integrated from PSoC Designer 4.3 EP_CY8C20x34 Extension Pack Version 2: 
 

1. CapSense User Module: Bug fixes and functional enhancements for CSA. 

2. Amplifier User Module: CMP. 

Integrated from PSoC Designer 4.3 EP_CY8C24x94 Extension Pack Version: 
 

1. Device support for CY8C24994-24LFXI (68-pin QFN; 8x8) and CY8C24994-24BVXI 
(100-ball BGA; 6x6). 

Integrated from PSoC Designer 4.3 EP_CYRF69xx3 Extension Pack Version 1: 
 

1. Device support for CYRF69103 and CYRF69213. 

2. Support for these user modules: 

MSTIMER 

PITIMER12 

USB 

E2PROM 

SPIM 

Parts Catalog for CYRF69xx3 
 
CYRF69103-40LFXC, CYRF69213-40LFXC. These are placed in the WUSB catalog group. 
These new parts are based upon the existing enCoRe parts CY7C60223 and CY7C63823, 
respectively. Their part catalog parameters are: 
 

Analog Blocks  -  0 
Digital Blocks  -  0 
Flash   8 K 
RAM   256 

IO Count  15 

Supply Voltage -  CYRF69103: 1.8 to 3.6,   CYRF69213: 4.0 to 5.5 

SMP   N/A 
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USB Interface   CYRF69103: N/A,   CYRF69213: “Low-Speed” 

Wireless Interface 2.4 GHz 

Temperature  COM (0 to 70C) 

Package  QFN 

PSoC Designer 4.4 Limitations 

 

These are the known issues with PSoC Designer 4.4: 

1. Due to the absence of signed drivers, operation of supported debugging/programming 
equipment under Windows Vista 64-Bit may only occur in Windows Test Mode using the 
provided test signed drivers. To enter Test Mode: 

a. Run an elevated privilege command window. 

i. In the start menu search type cmd 

ii. Right-click on cmd.exe and select Run as Administrator. 

iii. The command prompt should contain "Administrator:" in the title bar. 

b. Type and execute "bcdedit.exe /set TESTSIGNING ON". 

i. The result should be, "The operation completed successfully." 

ii. To verify, type bcdedit.exe again at the command prompt and under 
the Windows Boot Loader settings there should be a line that says 
testsigning Yes. 

c. Reboot the computer. When Windows Vista 64-Bit completes booting up, there 
will be "Test Mode" displayed in the 4 corners of the desktop. The Windows Vista 
64-Bit build number will be displayed at the top center of the screen. 

d. To optionally exit Test Mode when you are done debugging or programming, run 
an elevated privilege command window. Then type and execute bcdedit.exe 
/set TESTSIGNING OFF. Reboot the computer to complete the process. 

2. This version of software is no longer compatible with the ICE4000.  

3. User modules for the CY8C20x34 part family are different from user modules for other 
PSoC part families. As a result, if you clone a project originally designed for another part 
family (CY8C21x34, for example), the user modules from the old project will not be 
included. This may be addressed in a future version of PSoC Designer. In addition, you 
may be unable to modify pin settings in the cloned project. Closing the project and re-
opening it will reset the pins. 

4. If the EzI2C User Module is used in dynamic reconfiguration, it needs to be placed in a 
separate configuration other than the base configuration.  

5.  The I2C bootloader host application is not compatible with Windows Vista 64-Bit. 

6. If there are less than 5 CSA sensors available for additional CapSense inputs, it is not 
possible to add another slider to the application. A workaround is to temporarily reduce 
the number of sensors in the application in order to input the correct number of sliders. 
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7. The value for TMRCLKCR in the generated file, psocconfigtbl.asm on a CYRF69xx3 

project, is not generated correctly until you modify the values for the contributing global 
resource fields (Timer Clock, Timer Clock / N). 

8. CYRF69xx3 part numbers are not automatically selected in the device and device family 
dropdown lists of PSoC Programmer when you click the Program Part icon in the PSoC 
Designer toolbar. When working with a project for the CYRF69xx3 part family, you must 
manually select the device in PSoC Programmer. 

9. In psocdynamic.h function prototypes are created by PSoC Designer.  
IsdynamicXXXLoaded() is supposed to return a character but it does not. The function 
just loads the value into the A register. Adding #include "psocdynamic.h" fixes this 
problem. 

Interconnect View Errata 
 

1. Pins assigned to the analog mux bus in the interconnect view are not disconnected when 
the pin assignment is changed. The pin is disconnected in the device settings but the 
interconnect view still shows the line connected it to the analog mux bus. 

2. The CY8C24x94 and CY8C21x34 parts show the settings for “Xtal Out” and “Xtal In” for 
the crystal oscillator in the global parameters although this feature is not available on 
these two families of parts. To work around this issue, do not choose to use the crystal 
oscillator on these two families of parts.  

3. Right clicking and choosing pan mode within the pin out window, inside the interconnect 
view will generate a runtime error. To avoid this error choose the pan mode option within 
the interconnect window. 

Updates That Can Affect Previous Projects 
 

Floating-Point Math 

The floating-point implementation was completely rewritten in PSoC Designer version 4.3. 
Except for one feature, the new version implements the IEEE-754 standard for floating-point 
numbers (single precision). The omission is that denormalized numbers are truncated to ‘0’. 
Because the old implementation did not adhere to the IEEE standard, calculations using the 
new implementation are not necessarily identical to calculations using the old 
implementation. 

CSR User Module for CY8C21x34 

This UM was updated in PSoC Desginer 4.4. Projects generated with version 4.3 will require 
the “Update” function to be run when first opened. Projects incorporating a CSR slider will 
additionally require the CSR wizard to be re-run, which happens by right-mouse clicking the 
CSR UM icon and choosing “CSR Wizard…” No data needs to be changed or re-entered, just 
select “OK” to allow the tables to be rebuilt and the project update is complete. 

How to Protect Project from Unintentional Alteration 

In version 4.3, a new setting has been added to Project > Settings > Device Editor tab to 
lock-down a device configuration and prevent any device or user module updates. This is a 
check box labeled Lock device configuration. You may manually choose this or it is 
automatically set if you select Cancel or Revert from the Project Update dialog box. 
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Project Cloning Causes “Project Update” Dialog to Appear 

The best thing to do is to choose Update. If you choose Cancel or Revert, the Lock device 
configuration check box is set. To regenerate the configuration, you must go to Project > 
Settings > Device Editor tab and uncheck Lock device configuration. 

Unlocking a Project to Allow Regeneration 

If the Project Update dialog comes up and you choose Cancel, a project setting will occur 
that prevents the Generate Application from executing (the selection is grayed-out). To re-
enable Generate Application, go to Project > Settings > Device Editor tab and uncheck 
the Lock device configuration check box. 

PSoC Designer Project Migration Compatibility 
 

1. Two dialog boxes are encountered when opening a project from an older release: 

 The first is the Old Version dialog box. It notifies the user about the necessity to 
update the current project in order to comply with the current version of PSoC 
Designer and gives the option to perform a project update immediately or postpone it 
until later. Any changes made in boot.tpl, such as added jumps in the interrupt vector 
table, must be migrated to the new boot.tpl.  

 The second dialog is the Outdated User Modules dialog box. This dialog provides 
users with the list of outdated user modules. The update process happens 
automatically during the source generation. When source is generated, the new files 
are added to the project and the old file is moved to the backup directory. The 
interrupt files contain start and end markers for user code. User code placed within 
user code markers is automatically carried into the new file. For migration, make sure 
that user code is between user code markers following the first Generate 
Application invocation after upgrading to 4.2. You may need to modify the source 
code manually after the first application generation to avoid compilation errors. 

 You must generate the source before closing the updated project dialog box in order 
for the update to take effect. If source is not generated, old files remain in the project 
and the out-of-date status is lost. An updated file can be generated for your project at 
any time. Right click the file in the source tree and select Remove from Project. 
When source is generated, the new file is added to the project and the old file is 
moved to the backup directory. 

2. When migrating projects to the CY8C29x66 using cloning, the compiler and linker default 
to using the small memory model (SMM). Use the Project > Settings > Compiler tab to 
Enable paging for the large memory model (LMM). 

3. When migrating projects to the CY8C29x66 using assembly language:  

 Additional code is required to manage RAM pages. 

 A small number of user module API function calls may need changing. See AN2218, 
Large Memory Model Programming for PSoC for details. 

 A copy of AN2218, Large Memory Model Programming for PSoC is stored in the 
folder: <install_path>\Cypress MicroSystems\PSoC 
Designer\Documentation. 
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Projects from previous PSoC Designer releases have projectname_globalparams.inc and 
projectnameapi.h under the Library Source folder. These files were replaced with 
globalparams.inc and psocapi.h. You  can manually remove the outdated files by right clicking the 
file icon and selecting Remove from Project. 

I2C Bootloader Notes  
 

1. A simple schematic is shown in Figure 1 for set up and testing of the I2C Bootloader User 
Module. An example project is included in the following directory:  

<install_path>\Cypress MicroSystems\PSoC Designer
\Examples\BootLdrI2C\Rs232_I2C\ 
 

Figure 1. Example Schematic for an I2C Bootloader Project 
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This project implements a translator program to translate RS232 commands to I2C. This 
project is compatible with the host application included in the same examples directory. 
The host application reads and parses the download file <filename>.dld and passes it 
to the intermediate translator program. The I2C to RS232 translator is intended to run on 
a CY8C27443 device but can be easily altered to run on another PSoC device family. 
Both example applications include source code. 
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2. Both the I2C and USB host applications require that Microsoft .NET Framework Version 

2.0 be installed. If the automatic installation fails, the package may be downloaded from 
the Microsoft web site at: 

http://www.microsoft.com/downloads/details.aspx?familyid=0856EACB-4362-4B0D-
8EDD-AAB15C5E04F5&displaylang=en 

3. After installing the I2C bootloader host application, the application may fail to execute 
because some systems may not have the system file MSCOMM32.ocx installed. The file 
can be found in: 

<install_path>\Cypress MicroSystems\PSoC 
Designer\Examples\BootLdrI2C\Boot-
LoaderHostApp\I2C_Host_Bootloader_Vstudio05_src.zip 

Once unpacked the file is contained in the /resources directory, Installation of the file 
can be accomplished using the “Windows Start >> All Programs >> Accessories >> 
Command Prompt” window and the command 

>regsvr32 mscomm32.ocx 

The file mscomm32.ocx is also available for download from the Microsoft web site by 
searching for the filename “mscomm32.ocx.” 

4. Do not mix and match bootloader settings from project to project. Do not bootload a 
project made with a polled bootloader into running an interrupt-driven bootloader and vice 
versa. The same goes for the Read_Buffer_Types option if you are using the Full I2C 
Operation MUM selection. 

5. The BootLdrI2C User Module is incapable of being an I2C master. If master is desired, 
use the I2C UM. Multi-master operation is not possible with this configuration. 

 
Modifying a CY3214-PSOCEVALUSB Rev C or D Evaluation Board to Use CSD 
 
To use the CSD User Module with the CY3214 Rev C or Rev D evaluation board, you must use 
an external resistor (Rb) and an external capacitor (Cmod). The CY3214 allows two combinations 
of the external components. Either R7 and C8 must be used together, or R10 and C7 must be 
used together. Please see the diagram below for reference. 

For the CY3214, the value of R10 or R7 is 5.6 KΩ and the value of C7 or C8 is 10 nF. R10 is 
already connected to C7 at P0[5], the other end of R10 must then be connected to the pin 
specified as the Feedback Resistor Pin in the Device Editor. The same is true if using the R7 
and C8 combination.  
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Documentation 
 
User guides and key documents are located in the \Documentation subdirectory of the PSoC 
Designer installation directory. The default location is: 

C:\Program Files\Cypress MicroSystems\PSoC Designer\Documentation.  

This directory is accessed within PSoC Designer under Help > Documentation. The documents 
are .PDF files that require you to use Adobe Reader. 

Documents include (but are not limited to): 
 PSoC Designer: Integrated Development Environment User Guide 
 PSoC Designer: Assembly Language User Guide 
 PSoC Designer: C Language Compiler User Guide 
 PSoC Designer: PSoC Programmer User Guide 
 PSoC Designer: Libraries User Guide 
 PSoC Designer: Version 4.4 Release Notes 
 CY8C29x66  PSoC Mixed-Signal Array Data Sheet 
 CY8C27x43  PSoC Mixed-Signal Array Data Sheet 
 CY8C25-26xxx  PSoC Device Family Data Sheet 
 CY8C24794  PSoC Mixed-Signal Array Data Sheet 
 CY8C24x23A  PSoC Mixed-Signal Array Data Sheet 
 CY8C24x23  PSoC Mixed-Signal Array Data Sheet 
 CY8C22x13  PSoC Mixed-Signal Array Data Sheet 
 CY8C20x34  PSoC Mixed-Signal Array Data Sheet 
 CY8C26xxx_Master.pdf Interface Diagram/Worksheet 
 Web Help: Document Web Links 
 PSoC Technical Reference Manual (TRM) 
 Large Memory Programming  
 Migrating to the Large Memory Model PSoC Devices 
 PSoC Pod Compatibility Guide 
 PSoC Device Selector Guide AN2209 
 Flex-Pod Soldering Guide 

Supporting documents for PSoC Designer’s public-domain functionality, such as Find in Files 
text search (grep.pdf) and the build utility (make.pdf and sed.pdf), are located in 

<install_path>\Cypress MicroSystems\PSoC 
Designer\Documentation\Supporting Documents. 
 

Silicon Errata  
 

The most up-to-date versions of the silicon errata are available on the www.cypress.com web site 
by navigating to Errata Update > PSoC Mixed-Signal Controllers. 

PSoC Resources 
 
Training: We recommend that first time users download and take PSoC Designer Module 1: 
Introduction to PSoC and PSoC Designer Module 2: Designing with PSoC for free by visiting 
www.cypress.com/psoctraining.  

Discussion Forums: Several forums are setup to share technical issues, designs, and questions 
at www.psocdeveloper.com.  
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Technical Support: Online help is available from the www.cypress.com web site by navigating to 
Technical Support and creating a TightLink case, or searching our KnowledgeBase.  

CYPro Support: Customers requiring complex and/or extensive design may engage third party 
consultants that have been certified and have demonstrated competence in Cypress products. 
This list is available online at www.cypress.com/support/cypros. 

Cypress Online Store: Hardware and PSoC devices are available at the cypress online store at 
www.onfulfillment.com/cypressstore.  

For assistance go to http://www.cypress.com or contact technical support by calling 800-541-
4736 and selecting #8, or you can call the Applications Team at 425.787.4814. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Cypress Semiconductor

2700 162nd Street SW, Building D
Lynnwood, WA 98037 
Phone: 425.787.4400 

Fax: 425.787.4641 
Application Support Hotline: 425.787.4814 

http://www.cypress.com/  
Copyright © 2007 Cypress Semiconductor Corporation. All rights reserved. 

PSoC® is a registered trademark and PSoC Designer™, Programmable System-on-Chip™, and PSoC Express™ are trademarks 
of Cypress Semiconductor Corporation.  

All other trademarks or registered trademarks referenced herein are the property of their respective owners.  
The information contained herein is subject to change without notice. Made in the U.S.A. 
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